Installer un certificat tiers signé par une autorite
de certification dans ISE
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Introduction

Ce document décrit comment installer un certificat signé par une autorité de certification (CA)
tierce dans Cisco ldentity Services Engine (ISE).

Conditions préalables

Exigences

Cisco vous recommande de connaitre l'infrastructure a clé publique de base.

Composants utilisés

Les informations contenues dans ce document sont basées sur Cisco ldentity Services Engine
(ISE) version 3.0. La méme configuration s'applique aux versions 2.X

The information in this document was created from the devices in a specific lab environment. All of
the devices used in this document started with a cleared (default) configuration. Si votre réseau
est en ligne, assurez-vous de bien comprendre l'incidence possible des commandes.

Informations générales



Ce processus est le méme quel que soit le rdle de certificat final (authentification EAP, Portal,
Admin et pxGrid).

Configurer

Etape 1. Générer une demande de signature de certificat (CSR).

Afin de générer le CSR, accédez a Administration > Certificates > Certificate Signing Requests et
cliquez sur Generate Certificate Signing Requests (CSR).

Certificate Management v Certificate Signing Requests

System Certificates

{ILStechCaZEiealas Generate Certificate Signing Requests (CSR)

OCSP Client Profile
A Certificate Signing Requests (CSRs) must be sent to and signed by an external authority. Click '

Certificate Signing Requests request has been signed, click "bind" to bind the request to the signed certificate issued by that au

Certificate Periodic Check Se...

Certificate Authority N D Friendly Name Certificate Subject

1. Dans la section Utilisation, sélectionnez le role a utiliser dans le menu déroulant. Si le
certificat est utilisé pour plusieurs réles, vous pouvez sélectionner Multi-use. Une fois le
certificat généré, les réles peuvent étre modifiés si nécessaire.

2. Sélectionnez le noeud pour lequel le certificat peut étre généré.

3. Renseignez les informations nécessaires (Unité organisationnelle, Organisation, Ville, Etat et
Pays).

%ﬁ Remarque : dans le champ Common Name (CN), ISE renseigne automatiquement le nom
de domaine complet (FQDN) du noeud.

Caracteres génériques :

+ Si l'objectif est de générer un certificat générique, cochez la case Allow Wildcard
Certificates.

 Si le certificat est utilisé pour les authentifications EAP, le symbole * ne doit pas étre dans le
champ Objet CN car les demandeurs Windows rejettent le certificat du serveur.

* Méme lorsque la validation de l'identité du serveur est désactivée sur le demandeur, la
connexion SSL peut échouer lorsque le * est dans le champ CN.



« Ala place, un nom de domaine complet générique peut étre utilisé dans le champ CN, puis
le *.domain.com peut étre utilisé dans le champ Nom DNS alternatif du sujet (SAN).

% Remarque : certaines autorités de certification peuvent ajouter automatiquement le caractére
générique (*) dans le CN du certificat, méme s'il n'est pas présent dans le CSR. Dans ce
scénario, une demande spéciale doit étre émise pour empécher cette action.

Exemple de certificat CSR de serveur individuel :



Usage

Certificate(s) will be used for Multi-Use ~ ), You can use a single certificate for multiple
services, but doing s0 is not a recommended

practice. Rather, you should obtain individual
cartificates specifically for each service (for
example, one certificate each for Guest Portals,
EAPR, and pxGrid).

Allow Wildcard Certificates [ ] (i)

MNode(s)

Generate CSR's for these Nodes:

Mode C5R Friendly Name
abtomar30 abtomar30#Multi-Use
Subject
Comman Mame (CN)
SFQDNS$ @

Organizational Unit (OU)
Cisco TAC 0

Organization {0)
Cisco 0,

City (L)
Bangalore

State (ST)
Karnataka

Country (C)
IN

Subject Alternative Mame (SAN)

it IP Address w 10.106.120.87 ()
* Key type
RSA v O

Exemple de CSR générique :



Usage

Certificate(s) will be used for Multi-Use ~ ), You can use a single certificate for multiple
services, but doing so is not a recommended
practice, Rather, you should obtain individual
certificates specifically for each service (for
example, one certificate each for Guest Portals,
EAP, and pxGrid).

Allow Wildcard Certificates {_l.:'

Subject

Common Name (CN)
Mycluster. mydomain,com

)

(-
—

Organizational Unit (OU)
Cisco TAC )]

Organization (O]
Cisco

©

City (L)
Bangalore

State (ST)
karnataka

Country {C)
IN

Subject Alternative Name (SAN)

IP Address w 10.106.120.87

DNS Name v * mydomain.com 0]

* Key type

RSA v @®

% Remarque : chaque adresse IP de noeud de déploiement peut étre ajoutée au champ SAN
pour éviter un avertissement de certificat lorsque vous accédez au serveur via l'adresse |P.

Une fois le CSR créé, ISE affiche une fenétre contextuelle avec I'option de I'exporter. Une fois
exporté, ce fichier doit étre envoyé a l'autorité de certification pour signature.



Successfully generated CSR(s)

Certificate Signing request(s) generated:
abtomar30.abtomar.local#Multi-Use

Click Export to download CSR(s) or OK to return to list of CSR(s) screen

o)

Etape 2. Importer une nouvelle chaine de certificats.

L'autorité de certification renvoie le certificat de serveur signé avec la chaine de certificats
compléte (racine/intermédiaire). Une fois regus, procédez comme suit pour importer les certificats
dans votre serveur ISE :

1.

S

A

Afin d'importer tout certificat racine et (ou) intermédiaire fourni par l'autorité de certification,
naviguez vers Administration > Certificates > Trusted Certificates.

. Cliquez sur Import, puis sélectionnez le certificat racine et/ou le certificat intermédiaire et

cochez les cases appropriées telles qu'elles ont été appliquées pour I'envoi.

. Afin d'importer le certificat du serveur, naviguez a Administration > Certificates > Certificate

Signing Requests.

. Sélectionnez le CSR précédemment créé et cliquez sur Bind Certificate.

. Sélectionnez le nouvel emplacement du certificat et ISE lie le certificat a la clé privée créée

et stockée dans la base de données.

Remarque : si le rOle admin a été sélectionné pour ce certificat, les services du serveur ISE
spécifiques redémarrent.

Attention : si le certificat importé est destiné au noeud d'administration principal du
déploiement et si le réle Admin est sélectionné, les services sur tous les noeuds redémarrent
I'un aprés l'autre. Ceci est prévu et une interruption est recommandée pour effectuer cet
exercice.



Vérifier

Si le réle admin a été sélectionné lors de I'importation du certificat, vous pouvez vérifier que le
nouveau certificat est en place en chargeant la page admin dans le navigateur. Le navigateur doit
faire confiance au nouveau certificat d'administration tant que la chaine a été créée correctement
et si la chaine de certificats est approuvée par le navigateur.

a & https://abtomar30.abtormar.local/admin/loginjsp P~ac (2 |dentity Services Engine
| |a | Certificate b4 ) B
General Details Certification Path
Certification path
;) abtomar-WIN-231PNBSSIPH-CA 1 1 LK
BB abtomar 30.abtomar.local P
i

ldentity Services Engine

Intuitive network security

— Certificate status: Password

is certificate is OK.
L]
/

| BEE

Problems logging in?
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Pour une vérification supplémentaire, sélectionnez le symbole de verrouillage dans le navigateur
et, sous le chemin d'accés du certificat, vérifiez que la chaine compléte est présente et approuvée
par la machine. Il ne s'agit pas d'un indicateur direct indiquant que la chaine compléte a été
transmise correctement par le serveur, mais d'un indicateur du navigateur capable d'approuver le
certificat du serveur sur la base de son magasin d'approbation local.

Dépannage

Le demandeur n'approuve pas le certificat du serveur local ISE pendant une
authentification dot1x

Vérifiez qU'ISE passe la chaine de certificats compléte pendant le processus d'échange SSL.



Lorsque vous utilisez des méthodes EAP qui nécessitent un certificat de serveur (c'est-a-dire,
PEAP) et que l'option Valider l'identité du serveur est sélectionnée, le demandeur valide la chaine
de certificats en utilisant les certificats qu'il a dans son magasin d'approbation local dans le cadre
du processus d'authentification. Dans le cadre du processus de connexion SSL, ISE présente son
certificat ainsi que tous les certificats racine et (ou) intermédiaires présents dans sa chaine. Le
demandeur ne pourra pas valider l'identité du serveur si la chaine est incompléte. Pour vérifier que
la chaine de certificats est renvoyée a votre client, vous pouvez effectuer les étapes suivantes :

1. Afin d'effectuer une capture a partir d'ISE (TCPDump) pendant l'authentification, naviguez
vers Operations > Diagnostic Tools > General Tools > TCP Dump.

2. Téléchargez/ouvrez la capture et appliquez le filtre ssl.handshake.certificates dans
Wireshark et trouvez un défi d'acces.

3. Une fois la sélection effectuée, naviguez vers Expand Radius Protocol > Attribute Value
Pairs > EAP-Message Last segment > Extensible Authentication Protocol > Secure Sockets
Layer > Certificate > Certificates.

Chaine de certificats dans la capture.
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Si la chaine est incomplete, accédez a ISE Administration > Certificates > Trusted Certificates et
vérifiez que les certificats racine et (ou) Intermediate sont présents. Si la chaine de certificats est
passée avec succes, la chaine elle-méme doit étre vérifiée comme étant valide a l'aide de la
méthode décrite ici.

Ouvrez chaque certificat (serveur, intermédiaire et racine) et vérifiez la chaine de confiance en
faisant correspondre l'identificateur de clé de sujet (SKI) de chaque certificat a l'identificateur de



clé d'autorité (AKI) du certificat suivant dans la chaine.

Exemple de chaine de certificats.

Certificate 25 || Cersticaie 25 | Certificate P
|
Ganared | [sds | Comtensen Path Geeersl| Deteds | Certfntion Fais el | Detsle | Cerloasen Path
Ehae .-:AI:- - Shien | <Al L3 Tharee | <l -
Field Wphse - | Fede LT - Field Walse
Fubbe ke AEA [2H1 @) B CA vermion WA Pt key RSA (4356 BRx)
qu Sulrect Uey Meetfisr oy 33 a3 20 Je b 4b 0 33 SR RN SR G Cubjen Ky ierarier fe e Ba 3250 G2 A7 SR A6 U1 el LB L. T Ky Unage Qetel Sipurere, Darplicie Sgring, Ol
i Eehanced Key Ussge  Server sethentiostias (1,3 61,557.3.0) Bl Certificnte Templst,, GeblA Subnect Sy el 52 7 of 3 38 29 of d Al 19 L1 TR 4 00,
o Sulrject Aliermative o, P Addres=14.50 157020 - B hathgriny Koy Kerdd,,, E=yD=52 Ie o5 bc 36 25 o da 81 19 1§ Hi A ersan Wi
i Authr iy Kep Jhem,. EeyTi=ie M oo 8d 11 3bode dF of 86 L1 B R Digribution Ped., [1}JORL Cistrietion Poerk: Desiributian Fol. o) Bagic Cormiradnis  Sulzjed Type=CA, Faf Lengih Consiraini=,
[ CR1L Distribwtion Poi... [L]0SL Distribution Feint: Distriouson Fol | fatharny [nfarmadio.. [ L]Aasharity It Arpess Aroess Method i Thasmbring migari... shal
L Aty Fformat [Lpsamarny b Acness: sooess Mothad.. - o My s [l Shgradurg, CRrtfioste Superdg, 0L - o Thisvbring A AT 30 1] TRl da R JL 1IN L
i 1 L L] 1 [ L 112 *
] | 5 Vi
|
|
Copy ta b it Cogy tu Fie.... t Capy ha Rl
LT rtd abvout Lo plplE iy L e Bbost Carieany daa Lesas e aboal Qirpfope delzds
=] ac oK

La chaine de certificats ISE est correcte, mais le terminal rejette le certificat du
serveur ISE pendant l'authentification

Si ISE présente sa chaine de certificats compléte lors de la connexion SSL et que le demandeur
continue de rejeter la chaine de certificats, I'étape suivante consiste a vérifier que les certificats
racine et/ou intermédiaire se trouvent dans le magasin local d'approbations du client.

Afin de vérifier cela a partir d'un périphérique Windows, naviguez vers mmc.exe File > Add-
Remove Snap-in. Dans la colonne Composants logiciels enfichables disponibles, sélectionnez
Certificats et cliquez sur Ajouter. Sélectionnez Mon compte d'utilisateur ou Compte d'ordinateur
selon le type d'authentification utilisé (Utilisateur ou Machine), puis cliquez sur OK.

Dans la vue de la console, sélectionnez Autorités de certification racines de confiance et Autorités
de certification intermédiaires pour vérifier la présence des certificats racines et intermédiaires
dans le magasin d'approbations local.
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Pour vérifier facilement qu'il s'agit d'un probléme lié a la vérification de l'identité du serveur,
désactivez la case a cocher Valider le certificat du serveur dans la configuration du profil du
demandeur et testez-la a nouveau.
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Informations connexes

* Guide de 'administrateur de Cisco Identity Services Engine, version 3.0
» Assistance technique de Cisco et téléchargements
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A propos de cette traduction
Cisco a traduit ce document en traduction automatisée vérifiée par une personne dans le

cadre d’un service mondial permettant a nos utilisateurs d’obtenir le contenu d’assistance
dans leur propre langue.

Il convient cependant de noter que méme la meilleure traduction automatisée ne sera pas
aussi précise que celle fournie par un traducteur professionnel.



